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FPGA Potential

* Implementing computations in hardware can have
speed/energy advantages over software:
 Lithography simulation: 15x speed-up [Cong & Zhou,
TRETS 09]

e Linear system solver: 2.2x speed-up, 5x more energy
efficient [Zhang, Betz, Rose, TRETS 12]

* Monte Carlo simulation for photodynamic therapy: 80x
faster, 45x more energy efficient [Lo et al., J. Biomed
Optics’09]

e Option pricing: 4.6x faster, 25x more energy efficient [Tse,
Thomas, Luk, TVLSI'12]
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ardware Design is Difficult

FPGA “success stories” are pervasive, yet the technology
remains inaccessible to software engineers

* Requires use of hardware description languages: Verilog and
VHDL

Hardware design skills are rare:
e 10 software engineers for every hardware engineer*

N2

Make hardware design easier for hardware engineers

Allow software engineers to design hardware and reap
its energy/performance benefits

*Source: US Bureau of Labor Statistics, 2012



igh-level synthesis (HLS) with
-PGAS

* Plays a central role, enabling the automatic
synthesis of high-level, untimed or partially timed
specifications (e.g. C or System C) to low-level cycle
accurate RTL specifications

e Target devices includes application-specific
integrated circuits (ASIC) or field-programmable
gate arrays (FPGAS)

* |t can be optimized taking into account the
performance, power, and cost requirements



igh-level Synthesis Flow

PROCEDURE Test; E A B C D
VAR {
o G ¢ M
A,B,C,D,E,F,G:integer; S (+) Y
BEGIN [RegR1|  [RegR2)
Read(A,B,C,D,E); v 4«
F := E*(A+B); (») (=) o s
G := (A+B)*(C+D); T T "f\“') l\i)
Y Y &
Foa
. . Y
Input Behavioral Spec. Dataflow Scheduling
Data-path generation
A<0:7> B<0:7> Controller ROM: _ A<0:7> B<0:7>
\J R o
Mi 0000 : 11000000 0001 /M Controller description:
\
Y Y 0001 + 00100090 0019 Y Y S1: M1=1, Load Rl next S2;
[RegR1| [RegR2) 0010 : 00011000 0011 [RegR1]  [RegR2) S2: Load R2 next S3;
A » 0011 : 01000000 0100 S3: Add, Load R3 next S4;

}"\' S4: M1=0, Load Rl next...
"\i’__/

v Mapping to resources ! ,
(Binding) Controller (FSM) Generation




Scheduling

* How to assign the computations of a program into
the hardware time steps (clock cycles)?

* Must consider under given target clock period:
* Which operations can be scheduled in the same time
step?
* Which operations are dependent on others?



Schedule strategies

e As soon as possible (ASAP)
e As |ate as nossible (ALAP)

y

(a) Sorted DFG (b) ASAP schedule

Control Control
Step ASAP Step
BRONMO G
2 2 2@

(¥

.

(b) ALAP schedule
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igh-level Synthesis Flow

PROCEDURE Test; E A B C D
VAR {
o G ¢ M
A,B,C,D,E,F,G:integer; S (+) Y
BEGIN [RegR1|  [RegR2)
Read(A,B,C,D,E); v 4«
F := E*(A+B); (») (=) o s
G := (A+B)*(C+D); T T "f\“') l\i)
Y Y &
Foa
. . Y
Input Behavioral Spec. Dataflow Scheduling
Data-path generation
A<0:7> B<0:7> Controller ROM: _ A<0:7> B<0:7>
\J R o
Mi 0000 : 11000000 0001 /M Controller description:
\
Y Y 0001 + 00100090 0019 Y Y S1: M1=1, Load Rl next S2;
[RegR1| [RegR2) 0010 : 00011000 0011 [RegR1]  [RegR2) S2: Load R2 next S3;
A » 0011 : 01000000 0100 S3: Add, Load R3 next S4;

}"\' S4: M1=0, Load Rl next...
"\i’__/

v Mapping to resources ! ,
(Binding) Controller (FSM) Generation




Binding

* Assign (bind) each operation to a hardware
functional unit

* Example:

* LegUp uses bipartite matching-based binding [Huang
DAC’90] using the Hungarian Method (Polynomial order)

operations

edge costs

hardware functional units
12



AutoESL and Xilinx C-to-FPGA

design

—
® | High-level -
ﬁ; Spec (C, g Synthesis
o C++, a Directives
o | SystemC) |~
=l L
AutoPllot
Synthesns
RTL
)
;‘E, (SystemC, ] g
S | VHDL, |& &
® | Verilog) | -
AutoPilot g
Simulation o
RTL Simulation ,3-
Simulator Scripts 3

X|I|nx ISE
EDK

Bltstream_J

AutoPllot
Module

Generation

Implementatio
Scripts
RTL/Netlist

Xilinx
CoreGen
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Performance Feature: Loop

Pipelining

for (inti=0:i<N: i++)

sum[ij=a+b+c+d




Sequential Execution

for (inti=0;1<N; i++)
sumfij=a+b+c+d

1. Sequential Execution

1 2 3 4

Cycles: 5 6

Not efficient!

3 Cycles/Iteration
« Total Cycles: 3N
« Adders: 3
« Adder Utilization: 33%

/7 8 9
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Poop Pipelining

#pragma pipeline

for (inti=0;1<N; I++)
sumfij=a+b+c+d

3. Parallel Execution : Loop pipelining

Cycles: 1 2 3 4 5

Steady-state

Efficient!

1 Cycles/lteration
(steady-state)
Total Cycles: N+2

« Adders: 3
» Adder Utilization: 100%

16



igh-quality and rapid design
using HLS: Why?

* Embedded processors are in almost every SoC

* Huge silicon capacity requires a higher level of
abstraction

* With the HLS, the code density can be easily reduced by
7x-10x in C/C++

* Behavioral IP reuse improves design productivity

* Verification drives the acceptance of HLS
* |t avoids slow and error-prone manually RTL cording

* Trend toward extensive use of accelerators and
heterogeneous SoCs



-aster Adoption of
-PGAs: Why?

LS Tools with

* Less pressure for formal verification
* |terations of the FPGA design can avoid huge

manufacturing costs

* |deal for platform-based synthesis
* Achieve higher quality of results (QoR)

* More pressure for time-to-market

e Designers may accept increased performance, power, or
cost in order to reduce design time

* Accelerated or reconfigurable computing calls for
C/C++ based compilation/synthesis to FPGAs



Overv

ew of

LS Tools

Status Compiler Owner License Input Output Year Domain TestBench | FP | FixP
eXCite Y Explorations | Commercial C VHDL/Verilog | 2001 All Yes No Yes
it Impulse Commercial | Impulse-C VH.DL 2003 [mage Yes Yes No

loper Accelerated Verilog Streaming

Catapult-C Ca])éplf) Deﬂsngn Commercial C<C++ VHDIT/Venlog 2004 All Yes No Yes

ystems SystemC SystemC
Cynthesizer FORTE Commercial SystemC Verilog 2004 All Yes Yes | Yes
Bluespec BlueSpec Inc. Commercial BSV SystemVerilog | 2007 All No No No
CHC Altium Commercial C subset VHDL/Verilog | 2008 All No Yes | Yes
% CtoS Cadence Commercial _I.Slz’;};g]f; Svyi:::l;%: 2008 All O:clgug,tfa le No Yes
- DK Demgn Memgr Commercial | Handel-C VH.DL 2009 | Streaming No No Yes

Suite Graphics Verilog
GAUT U. Bretagne Academic C/IC++ VHDL 2010 DSP Yes No Yes
MaxCompiler Maxeler Commercial MaxJ RTL 2010 | DataFlow No Yes No
ROCCC Jacquard Comp. | Commercial C subset VHDL 2010 | Streaming No Yes No
Syanhony Synopsys Commercial C/C++ VHS]; E{:{il&mg 2010 All Yes No Yes
Woaber NEC Commercial | BDL xe'jlll)olé 2011 | Al eIl Yes | Yes
LegUp U. Toronto Academic C Verilog 2011 All Yes Yes No
Bambu PoliMi Academic C Verilog 2012 All Yes Yes No
DWARV TU. Delft Academic C subset VHDL 2012 All Yes Yes Yes
VivadoHLS Xilinx Commercial | 'C++ | VHDLNVerilog 150,51 4y Yes | Yes | Yes

SystemC SystemC
Trident Los Alamos NL Academic C subset VHDL 2007 | Scientific No Yes No
< CHiMPS U. Washington Academic C VHDL 2008 All No No No
< Kiwi U. Cambridge Academic C# Verilog 2008 .NET No No No
gcc2verilog [45] U. Korea Academic C Verilog 2011 All No No No
HerculeS Ajax Compiler | Commercial C/NAC VHDL 2012 All Yes Yes | Yes
Napa-C Sarnoff Corp. Academic C subset VHDL/Verilog | 1998 Loop No No No
DEFACTO U. South Cailf. Academic C RTL 1999 DSE No No No
- Garp U. Berkeley Academic C subset bitstream 2000 Loop No No No
2 MATCH U. Northwest Academic MATLAB VHDL 2000 Image No No | No
S PipeRench U.Carnegie M. Academic DIL bitstream 2000 Stream No No No
E SeaCucumber U. Brigham Y. Academic Java EDIF 2002 All No Yes | Yes
« SA-C U. Colorado Academic SA-C VHDL 2003 Image No No No
SPARK U. Cal. Trvine Academic C VHDL 2003 Control No No No
AccelDSP Xilinx Commercial | MATLAB | VHDL/Verilog | 2006 DSP Yes Yes | Yes
C2H Altera Commercial C VHDL/Verilog | 2006 All No No No
CtoVerilog U. Haifa Academic C Verilog 2008 All No No No

J. Cong et. al, “A survey and evaluation of FPGA high-level synthesis tools,” IEEE Trans.

on CAD, 2015.



Productivity

KGate
140
)]
N ¢ ANSI C
% 120 = Verilog
= 100
O
- 80
Q
© 60
2
o 40
Q) Source:
20 B. Carrion Schafer
Tool:
0 NEC CWB
0 5 10 15 20 25 KL
Code Size

RTL (Verilog) 4 gates/line
Behavioral C 28 gates /line

=>»7x more productive
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RTL Expert vs.

LS Expert

SPHERE DECODER IMPLEMENTATION RESULTS

Metric RTL Expert | AutoPilot Expert | Difference (%)
Dev. time (man-weeks) 16.5 15 -9
LUTs 32708 29060 —11
Registers 44 885 31000 —31
DSP48s 225 201 —11

18K BRAMs 128 99 —26

8 x 8 RVD-QRD IMPLEMENTATION RESULTS

Metric RTL Expert | AutoPilot Expert | AutoPilot Expert
Dev. time (man-weeks) 4.5 3 5

LUTs 5082 6344 3862
Registers 5699 5692 4931
DSP48s 30 46 30

18K BRAMs 19 19 19

J. Cong et. al, “High-level synthesis for FPGAs: From prototyping to deployment,” IEEE Trans. on CAD, 2011.
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Walk Throu:

oh HLS Desi;




Vivado HLS Design Flow

* Design C/C++ code for your target specification in advance
J

* Create a new project

» Refactoring for HLS suitable C/C++ -

* High-level synthesis ~ [, ]

e RTL-C Co-verification (Optional)

* [P generation —

NY
* Integrate HW on Vivado block diagram design \/|\/ADQ‘

* Design SW on XSDK
e Run on your FPGA board

Software Development Kit



Design a Specification by C/C++

* See, Github for lecture 9: float._ mult.c

<{stdio.h>
<{stdlib. h)>

ERROR THRESH-0. 1
void-float mult(float-a, -float-b, float *c)

¥c-=--a %'b;

}

int-main(void)

[ -float-fres, fia, fib, fref, -err;
int-ec-=-0;
(unsigned-int-i-=:0; i
fia-=-(rand()-% /
fib-=-(rand() -%-1¢ /
float mult(fia, -fib, -&fres)

fref-=-fia-x-fib;

err-=-fref - fres;
(-err-<-0)-err-*=--1.0;
printf("fia=%f fib=%f fres=%f fref=%f”, -fia, -fib, - fres, -fref);
(-err->-ERROR THRESH) - {
ectt;
printf(” -ERROR¥n”);

printf("¥n”);

0) printf(”[Test-Passed]¥n”); printf(”[Test-Failed]¥n”);




Create a New Project

* Windows: Start > All Programs > Xilinx Design Tools
> Vivado 2017.4 > Vivado HLS > Vivado HLS

e Linux (Ubuntu):
#tsource /opt/Xilinx/Vivado/2017.4/settings64.sh
ftvivado _hls &



On the Vivado HLS Welcome Page

* In the Welcome Page, select "Create New Project”
to open the Project wizard.



On Project Configuration Page

°* a. Enter t
e b. Entert

ne project name as "lec_ 9"
ne project Location as "C:¥FPGA¥HLS"

(Windows), "/home/(usrname)/FPGA/HLS" (Ubuntu)
e C. Click Next

f

Project Configuration A C_
= Stl
Create Vivado HLS project of selected type {
Project name: llec_9 l

Location: lC:¥FPGA¥HLS Browse...




On an Add/Remove Files Dialog

e Enter the following information to specify the C design files:
* a. Click Add Files.

* b. Select "float_mult.c" and click Open.

e c. Use Browse button to specify "float._ mult" as the top-
level function.

e d. Click Next.

¢ New Vivado HLS Project O X

Add/Remove Files

Add/remove C-based source files (design specification) %y
i

Top Function: |float_mult ‘ IBrowse...l
Design Files
Name CFLAGS Add Files...
float_mult.c New File...
Edit CFLAGS...
Remove




Add/Remove C-based Testbench Files

e Click the Add Files button to include both test bench files
"float._mult.c"

 Then, Click Next.

e Both C simulation and RTL co-simulation execute in
subdirecﬁories of the solution.

/

Add/Remove Files

Add/remove C-based testbench files (design test) %y

»>

TestBench Files

Name CFLAGS Add Files...
float It.
oat_mult.c New File..
Add Folder...

< Back 5 Cancel



Solution Configuration

e Accept the default solution name (solutionl), clock period
(10 ns), and clock uncertainty (defaults to 12.5% of the clock

period, when left blank/undefined)

* Click the part selection button to open the part selection

window

¢ Device Selection Dialog

Select: i Boards

Filter

Product Category: | General Purpose

Family:

Sub-Family:

zynq
zynq

Reset All Filters

v | Package:

clg400

v | Speed grade: | -1
v | Temp grade: | ¢

Search: ¥

X

Part

‘\é\ xc72020clg400-1
&P xc72014sclg400-1
&9 xc72010clg400-1
& xc72007sclg400-1

Family Package
clg400

Y clg400

zZynq clg400

zynq clg400

o
m

o
- o -

SLICE LUT FF

13300 53200 106400
10150 40600 81200
4400 17600 35200
3600 14400 28800

DSP

220
170
80
66

BRAM

280
214
120
100

Canc

el




Cont'd

e Carefully Select Your FPGA on the Zybo!!

e From the list of available devices

e Click "OK", and click "Finish"

/

Solution Configuration

Create Vivado HLS solution for selected technology

Solution Name: l solution

Clock

Period: |10 l Uncertainty: |

Part Selection

Part: xc7z010clg400-1

< Back Finish

Cancel



file Edit Project Solution Window Melp

r R NS GET Pl B e
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T

&) Incudes

O Test Berch

8 Source Toolbar Buttons

« ¥+ solution?
« & constraints
o directivestel
¥ scriptecl

Project
Explorer
Pane

F

Information
Pane

© Console 1 @) Errors & Warnings
CDT Build Console [fir_prj]

Console
Pane

1 item selected

@ |

Auxiliary
Pane
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=
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Refactoring your C/C++ Code

e See, Github: hls_float mult.c
e Define an union variable

* Insert pragmas

6~ typedef union _ftoi {
7 float f;

8 unsigned int u;
9 } ftoi;

11= int float_mult(float a, float b, float *c)

12 {

13 #pragma HLS INTERFACE s_axilite register port=c bundle=slv@

14 #pragma HLS INTERFACE s_axilite port=b bundle=slve

15 #pragma HLS INTERFACE s_axilite port=a bundle=slv@

16 #pragma HLS INTERFACE s_axilite register port=return bundle=slv@

18 static int cycle = @;

20 *c= a* b;
21 cycle++;
23 return cycle;



Validate the C/C++ Code

e 4. Click the Run C Simulation button, or use menu Project >
Run C Simulation, to compile and execute the C design.

¢ Vivado HLS 2017.4 - lec_9 (C¥FPGA¥HLS¥lec_9)

File Edit Project Solution Window Help
B4 BEX O REGBBRIP-UB A-0F @
LCI Ex &3 = 0 lg) float_mult.c &2 I Run C Simulation l

o~
N

=

[ M -~

1 #include <stdio.h>
2 #include <stdlib.h>

* 5. In the C Simulation dialog box, click OK.
* The Console pane confirms the simulation executed successfully.

&) Console &3
Vivado HLS Console

fia=9.
fia=1.
fia=7.
.430000

fia=6

fia=8.
fia=3.
fia=8.

[Test
INFO:
INFO:

oeeeeo
270000
230000

a7eee0
loeeee
13eeee

Passed]

Q] Errors| & Warnings

fib=7.
fib=4.
.930000
fib=4.
fib=4.
fib=6.
fib=5.

fib=8

380000
6706000

830000
210000
170060
140000

fres=70.919998 fref=70.919993
fres=5.930980 fref=5.938900

fres=65.0210406 fref=65.0108406
fres=31.298399 fref=31.298399
fres=33.974701 fref=33.974701
fres=19.126999 fref=19.126999
fres=41.788200 fref=41.788200

[SIM 211-1] CSim done with @ errors.
[SIH 211_3] B e e CSIM finish B ek e e e
Finished C simulation.



igh-Level Synthesis

* Click the Run C Synthesis toolbar button or use the
menu Solution > Run C Synthesis > Active Solution

* When synthesis completes, the report file opens
automatically
* Because the synthesis report is open in the Information

pane, the Outline tab in the Auxiliary pane automatically
updates to reflect the report information.

ac_9 (C¥FPGA¥HLS¥lec 9)

ution Window Help
BR G R ECGOEREI P 2= R

1c] float_mult.c =| float_mult_csim.log &3

Run C Synthesis
-INFO: [SI.“ 2] EREEEEEREER KRR K XX CSII.'1 Start Er E T+ 2 TTTTT

- TMAL FeeTaa 47 r/meTaa 271170 Tmsccm e £~ e 2l P [




Performance Estimation

e Check "Performance Estimates' in the Outline tab

* |In the Performance Estimates pane, you can see that the clock period is
set to 10 ns. Vivado HLS targets a clock period of Clock Target minus
Clock Uncertainty (10.00-1.25 = 8.75 ns in this example).

* The clock uncertainty ensures there is some timing margin available
for the (at this stage) unknown net delays due to place-and-routing

* The estimated clock period (worst-case delay) is 6.70 ns, which meets the
8.75 ns timing requirement

Performance Estimates

-] Timing (ns)

=] Summary

Clock Target Estimated Uncertainty
ap_clk  10.00 6.70 1.25

-] Latency (clock cycles)

=] Summary

Latency Interval
min - max min max lype
4 4 4 4 none



Utilization Estimation

* The resource utilization numbers are estimates
because RTL synthesis might be able to perform
additional optimizations, and these figures might
change after RTL synthesis.

Utilization Estimates

-] Summary
Name BRAM_18K DSP48E FF LUT
DSP - - - -
Expression - - 0 39
FIFO - - - -
Instance 0 3 325 617
Memory - - - -
Multiplexer - - - 33
Register - - 102 -
Total 0 3 427 689
Available 120 80 35200 17600

Utilization (%) 0 3 1 3



Interface Report

* The Interface section shows the ports and 1/0
protocols created by interface synthesis

Interface
B Summary
RTL Ports Dir Bits Protocol Source Object CType
s_axi_slvO_ AWVALID in 1 s_axi slv0 pointer
s_axi_slvO AWREADY out 1 s_axi slv0 pointer
s_axi_slvO_AWADDR in 6 5_axi slv0 pointer
s_axi_slv0_WVALID in 1 s_axi slv0 pointer
s_axi_slvO WREADY out 1 s_axi slv0 pointer
s_axi_slvO_WDATA in 32 5_axi slv0 pointer
s_axi_slvO_WSTRB in 4 s_axi slv0 pointer
s_axi_slvO_ARVALID in 1 s_axi slv0 pointer
s_axi_slvO_ARREADY out 1 5_axi slv0 pointer
s_axi_slvO_ARADDR in 6 s_axi slv0 pointer
s_axi_slv0_RVALID out 1 s_axi slv0 pointer
s_axi_slvO_RREADY in 1 5_axi slv0 pointer
s_axi_slvO_RDATA out 32 s_axi slvO pointer
s_axi_slvO_RRESP out 2 s_axi slv0 pointer
s_axi_slv0_BVALID out 1 5_axi slvO pointer
s_axi_slv0_BREADY in 1 s_axi slv0 pointer
s_axi_slvO_BRESP out 2 s_axi slv0 pointer
ap_clk in 1 ap_ctrl_hs float_mult return value
ap_rst_n in 1 ap_ctrl_hs float_mult return value
interrupt out 1 ap_ctrl_hs float_mult return value



IP Creation

The final step in the High-Level Synthesis flow is to

package the design as an IP block for use with — S =0
other tools in the Vivado Design Suite v Sl
m Includes
1. Click the Export RTL toolbar button or use the = B float multc
menu Solution > Export RTL e
v = solution1
. @ constraints
2. Ensure the Format Selection drop-down menu & csim
v (= impl
shows IP Catalog S
. =| autoimpl.log
3. Click OK. The IP packager creates a package for 8 awiraml
. |=] component.xm
the VlvadO |P Cata|0g [5 float_mult_info.xml
g pack.bat
4. Expand Solutionl in the Explorer X ooppackte

=| vivado.jou

5. Expand the impl folder created by the Export

E xilinx_com_hls_float_mult_1_0.zip

RTI_ Command % constrainis
& bd
6. Expand the ip folder and find the IP packaged as = dor

a zip file, ready for adding to the Vivado IP Catalog
(See, right)



Import to IP Catalog

e Create a new project on Vivado, then create a block design

* Project name as "hls_walk_through 1"

e RTL project, no add sources, constraints, and specify your Zybo
board

° Clle an ”lP Settlngs" on 3a dlagr*\m +thAan AnAn A ArAaiA~t

Diagram

settings window % o® o + @ c

Right click on a "Diagram'

+ Addip.. ¢ = button to add IP
Add Module...
IP Settings...

[¥ validate Design

Menntn Llincarabho



Add a Path to IP Repositories

* Add a path to Repository manager for the IP generated on Vivado HLS
* |n the tutorial, the IP pathis "C:/FPGA/HLS/lec_9/solution1/impl/ip"
* Make sure your "Float._ mult" is Ioadgzd

' |
1
IP > Repository
Project Settings Add directories to the list of repositories. You may then add additional IP to a selected '
repository. If an IP is disabled then a tool-tip will alert you to the reason.

General

Simulaion

Elaboration sitories ’

Synthesis

Implementation

Bitstream / o 1 repository was added to the project
~ P

No content
Repository
PE :
Repository
Tool Settings Refresh Al - FPGAM | lution /i i
— v C
Project = C./FPGA/HLS/lec_9/solution1/implfip
- v IPs (1
¢ IP Repositories v
4F Float_mult (xilinx.com:hls:float_mult1.0
Recent: | - C:/FPGA v 2O = ey BEXDTH

 Directory: C:\FPGAHLS\ec_9\solution1\implhip
o ok |
v solution1 &

.autopilot

>
> tcls
> csim
v impl
v ip
> Xil

~

\@) “ I Cancel I l Apply ‘ ’Bestore...l




System Generation

* On Block Design, instance a "ZYNQ7 Processing System"
* Then, also instance your IP core "float._mult"

* Next, concatenate with them (Processor System Reset and AXI
Interconnect are inserted automatically)

Diagram X Address Editor X

@ o ¥ & Q + ¥ C o
* Designer Assistance available. Run Block Automation('(Run Connection Automation
rst_ps7 _0_S0M
roat_muIt_O slowest snc ck nb_resct =
oxt resa in s stuc resedD O] =
= ¢y s_axi_AXILiteS @ aux resct in poriphenal rese{00]
H Vivado™ HLS - mb_dcbug sys rst Interconnect ancsen{00)
" + ap_ctrl [ o dem locked periphenal_aresan(00]
ap_clk g
ap_rst_n
Float_mult (Pre-Production)
processing_system?7_0
’ or + ||} {O oor
processing_system7_0 FoE0 0 + ||} {O Fixeo_10
- wano o + ||| -
DDR + " Ll = ZYNO M GO+ G
- FIXED_IO +||| FCIK_CIXD
M_AXI_GP0_ACLK ZYNQ M_AXI_GPO + i} FOLK_RESETO_N g

FCLK_CLKO ZYNQ7 Procassing System

FCLK_RESETO_N

ZYNQ7 Processing System




Generate Bitstream

To re-use HDL design flow, do following steps:

1. Right-click on "design 1", and select "Generate Output
Products...", then "Generate"

2. Again, Right-click on "design 1", and select "Create HDL
Wrapper...", then "OK"

b Design Sources (1

%1 design_1 (design_1 hd)

> Constraints Source Node Properties...

v Simulation Sources (1 = OpenFile

’ sim_1 (1 & Create HDL Wrapper... D
View Instantiation Template
& Generate Output Products... >
Reset Output Products...




Synthesis

/

ardware and Export

hello_world_1 - [C:/FPGA/lec2_1/hello_world_1/hello_world_1.xpr] - Vivado 2017.4

File

Click "Generate Bitstream", then "Yes" n

and "OK"

After finish bitstream generation, then

"Cancel"

In "Menu",
then "Export Hardware"

Check "Include bitstream",

select "File" and "Export",

then "OK"

Edit  Flow Tools

New Project...
Open Project...
Open Recent Project

Open Example Project...

Save ProjectAs...
Write Project Tcl...
Archive Project...

Close Project

Save Block Design As...

Close Block Design

Open Checkpoint...

New IP Location...

Open IP Location...

New File...

Open File...

Open Recent File
Open IP-XACT File...

Add Sources...

Open Source File...

Export
Launch SDK
Open Log File

Open Journal File

Window

Layo

3

ICK
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L}
Developing SW =~ *
p g Application Project B
Create a managed make application project.

Project name: | zynq_float_mult |

* From the SDK File menu, select New > Use default location

 Launch SDK on Vivado

Appllcatlon PrOJect. C¥FPGA¥Vivado¥hls_walk_though_1¥hls_walk_though_1.sdk? Browse...
. . default
a. In the New Project dialog enter the
project name "Zynq_ﬂoat_mu|t" 0S Platform: | standalone v
b. Clle Next. Target Hardware
Hardware Platform: |design_1_wrapper_hw_platform_0 v | | New...
c. Select the "Hello World" template.  secescon B — S
d. Click Finish
Target Software
Language: @C OC++
32-bit
N/A

Board Support Package: (® Create New | zynq_float_mult_bsp

':?/' < Back Next > Cancel




Execute "Hello World" SW

* Power up the Zybo board and test the Hello World
application

e Ensure the board has all the connections to allow
you to download the bitstream on the FPGA device

e Click Xilinx > Program FPGA (or toolbar icon)

[E] SDK Log 53 e = O
@1:58:38 INFO : XSCT server has started successfully. A
@1:58:40 INFO : Successfully done setting XSCT server connection che
@1:58:40 INFO : Processing command line option -hwspec C:/FPGA/Vivac
@1:58:40 INFO : Successfully done setting SDK workspace

©2:17:15 INFO : Connected to target on host '"127.8.8.1"' and port '31
©2:17:17 INFO : 'targets -set -filter {jtag cable name =~ “"Digilent
©2:17:18 INFO << FPGA configured successfully with bitstream "C:/FPGA

v



Cont'd

* Click on SDK Terminal and click on add button to add a port to the
terminal

a. Click the Connect icon (See, bottom)

b. Select Connection Type > Serial.

c. Select the COM port to which the USB UART cable is connected
d. Change the Baud Rate to 115200

e. Click OK to exit the Terminal Settings dialog box.

pPei_ari_1 yrncnic
<

Overview | Source

3 [flPr. FHTa.. BCo.. [JPr. BESD. 2 = B [E]SDKLlog &2

@ / 81:58:38 INFO
- 21:53:40 INFO

[ Connect to serial port. j INFO
|7 21:58:4@ INFO
©2:17:15 INFO

©2:17:17 INFO

92:17:18 INFO

|| Send | | Clear <




Terminal Settings Dialog

e Right-click the application project "zyng_float._ mult" in the Explorer panel

a. Click Run As > Launch on Hardware.

e Switch to the Terminal tab and confirm that "Hello World" was received
* Or, you can use TeraTermianl (Windows) GtkTerm (Ubuntu)

|@ ps7_initc
[Ej ps7_init.h
@ ps7_inithtml
= ps7_inittcl
[ system.hdf

v (% zynq_float_mult
¥ Binaries
[ Includes
(= Debug
& src

@, zynq_float_mult

2 Target Connections
(= Hardware Serve
(= Linux TCF Agen
(= QEMU TcfGdbC

(&)

b

New

Go Into

Open in New Window

Copy
Paste
Delete
Source
Move...

Rename...

Import...
Export...

Build Project
Clean Project
Refresh

Close Project

Close Unrelated Projects
Build Configurations

Run As
Debug As
Compare With

Target Information

This Board Support Package is compiled to run on the following target.

Hardware Specification: C¥FPGA¥Vivado¥hls_walk_though_1¥hls_walk_though_1.s
Target Processor: ps7_cortexa9_0

Ctrl+C
Ctrl+V

Delete

F2

Fs

>

>

age OS.

andalone
5

rofiling, abort and exit.

tandalone v6 5

e Board Support Package.

It_0 float_mult
fi_0 generic
fi_1 generic

at 115200

TCF

tandalone is a simple, low-level software layer. It provides access
terrupts and exceptions as well as the basic features of a hosted

SDK Log 52

@ K L 21:58:38 INF(
91:58:40 INF(

01:58:408 INF(

A ©1:58:408 INF(
©2:17:15 INF(

1 Launch on Hardware (System Debugger)

B 2 Start Performance Analysis

TCF

3 Launch on Hardware (System Debugger on QEMU)

El sD...

Connected to: Serial ( COMS8 5200, 0, 8

Already connected to port: COM8Hello World

Send

Clear



Modify SW to Communicate with
Your IP Core

* The "float._ mult" function has "a" and "b" as inputs

and "c" as an output

* Following processing exists in the APl generated by
Vivado HLS

e Setvaluetoa
e Setvaluetob
e Read the value of c

* |n order to control the hardware, there is an API
that performs the following processing
* Start operation
 Terminate of calculation



APls for a Generated |P Core

* The IP core APl is stored in the following directory (in this
example)

design 1 wrapper_hw _platform_0/drivers/float _top v1 0/
src

* |In the directory, the following files are stored

xfloat_top_hw.h

xfloat_top_linux.c

xfloat_top_sinit.c

xfloat_top.c

e xfloat top.h

* The detail of the defined APl is described in "ug902-vivado-
high-level-synthesis.pdf"
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SW Code for an ARM Processor on Zybo

* See, Github: sw_code.c

#include <stdio.h>
#include "platform.h”
#include "xfloat_mult.h"
#include "xparameters.h”

= typedef union _ftoi {
float f;
unsigned int u;
} ftoi;

// from xparameters.h
#define XF_DEVICE_ID  XPAR_FLOAT_MULT_@ DEVICE_ID

XFloat_mult XFT;// Instance for Vivado HLS Generated IP

// Testbench
= float ref_float_mult( float a, float b)
{

return a * b;

}

.~ int main()

1
int i,Status;
XFloat_mult_Config *ConfigPtr;
ftoi ref_a, ref_b, out_c;
ftoi in_a, in_b;
int cycle;

// Initialization
init_platform();
XFloat_mult_Initialize( &XFT,XPAR_FLOAT MULT @ _DEVICE_ID);

ConfigPtr = XFloat_mult_LookupConfig(XF_DEVICE_ID);
Status = XFloat_mult_CfgInitialize(&XFT, ConfigPtr);
if (Status != XST_SUCCESS) {

return XST_FAILURE;

}
Status = XFloat_mult_IsIdle(&XFT);

Status = XFloat_mult_IsIdle(&XFT);

for (i=0;i<10;i++) {
printf("TEST LOOP %d:\n",1i);
ref_a.f = (float)i;
ref_b.f = (float)(i*1@@ + 1i);
while(!XFloat_mult_IsReady(&XFT)) ; // Check Ready Signal
XFloat_mult_Set_a(&XFT, ref_a.u); // Set register a
XFloat_mult_Set b(&XFT, ref_b.u); // Set register b
in_a.u = XFloat_mult_Get_a(&XFT);
in_b.u = XFloat_mult_Get_b(&XFT);
printf(" Get value a = %f(%x), b = ¥f(%x)\n",

in_a.f,in_a.u,in_b.f,in_b.u);

XFloat_mult_Start(&XFT); // Start HW
while (!XFloat_mult_IsDone(&XFT)) ; // Wait Done signal

out_c.u = (unsigned int)XFloat_mult_Get_c(&XFT); // Load register c
cycle = XFloat_mult_Get_return(&XFT);

printf("%d: Get value c = %¥f(¥x)\n", cycle, out_c.f,out_c.u);

if ( ref_float_mult(ref_a.f, ref_b.f) != out_c.f ) // Compariscn
printf(" ERROR! ref = ¥f, val = %f\n",
ref_float_mult(ref_a.f, ref_b.f),out_c.f);
¥

printf("float_mult test done.\n");
cleanup_platform();
return @;



Execution Results

T Tera Term - [EEEIVT
IJ74IUF) |EE) FES) IVPO-JHO) D4VEIW) AT (H)
13: Get value ¢ = 404.000000(43ca0000)
TEST LOOP 3:
Get wvalue a = 3.000000(40400000), b = 303.000000(43978000)
. Get wvalue ¢ = 909.000000(44634000)
TEST LOOP 4:
Get wvalue a = 4.000000(40800000), b = 404.000000(43ca0000)
15: Get wvalue ¢ = 1616.000000(44ca0000)
TEST LOOP 5:
Get value a = 5.000000(40a00000), b = 505.000000(43fc8000)
. Get wvalue ¢ = 2525.000000(451dd000)
TEST LOOP 6:
Get wvalue a = 6.000000(40c00000), b = 606.000000(44178000)
17: Get wvalue ¢ = 3636.000000(45634000)
TEST LOOP 7:
Get wvalue a = 7.000000(40e00000), b = 707.000000(4430<000)
18: Get value ¢ = 4949.000000(4592a800)
TEST LOOP 8:
Get value a = 8.000000(41000000), b = 808.000000(444a0000)
19:  Get value ¢ = 6464.000000(45ca0000)
TEST LOOP 9:
Get value a = 9.000000(41100000), b = 909.000000(44634000)
20: Get value ¢ = 8181.000000(45ffa800)

float_mult test done.




summary

* HLS brings value to the FPGA design:

* Make hardware design easier for hardware engineers

* Allow software engineers to design hardware and reap
energy/performance benefits

* Benefits: Productivity, lower non-recurring
engineering costs, maintainability, faster time to
market

e Execute a tutorial through a floating point precision
multiplication



Exercise

* (Mandatory) Describe the advantage and the
disadvantage for the high-level synthesis based design
comparing with the RTL based design

* (Mandatory) Execute a tutorial for a floating point
precision multiplication on your Zybo board

* (Optional) Compare with non "#pragma HLS pipeline"
version, and report differences of pipelined one

Send a report to OCW-i
Deadline is 28th, July, 2020 JST PM 13:20
(At the beginning of the next lecture)
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